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DOUQ Volz Helping people use Oracle since 1990 +1 510 755 7050

doug@volzconsulting.com

[0 Professional Summary www.volzconsulting.com

[0 Business Solutions

35+ years industry, design and consulting and “firefighting” experience
Specializing in Cost Management business solutions

Recognized by Industry Peers with numerous OAUG awards:
« 2014 OAUG Member of the Year, 2018 Presenter of the Year, 2018 Special Interest Group of the Year

Co-designed Oracle Cost Management at Oracle

Implementations with international consulting firms, in twelve countries
Led the Oracle Applications User Group for Cost Management since 2007
Presenter at Collaborate (OAUG) and UKOUG since 1996

Prior industry positions for General and Cost Accounting management

Change cost methods Fix system account setups

Inventory reconciliation - Multi-org cost accounting reports

Product Line & Margin analysis
Cost Rollup and Update
Cost accounting training

Profit in inventory

Intercompany

A/P accruals
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Solutions You Can Use

— https://www.oatug.org/education-events/knowledge
— http://www.volzconsulting.com/resources.html

Over 30

Presentations!
A/P Accruals: OAUG/Collaborate & UKOUG

1996/2007/2008: (R11i) How to Setup, Use and Balance Your A/P Accrual Accounts
2011: A/P Accruals for Release 12 (OAUG Cost Management SIG)

Cost Management & SLA: OAUG/Collaborate & UKOUG
2009: Cost Accounting As You Want It — EBS R12 Cost Accounting with SLA
2013: Subledger Accounting for Discrete & EAM Cost Accounting: Product Line and Expense Accounting Made Easy
2014: How to Create Shipping Burdens for Oracle Cost Management, in Spite of Subledger Accounting

Changing Cost Methods: OAUG/Collaborate
2016: Who Said Changing Cost Methods With Discrete Costing Can't be Done?

Discrete & Process Cost Accounting Integration: OAUG/Collaborate
2015: We Can Create Combined Oracle Cost Accounting Reports for Both Discrete and Process MFG!

Inventory Reconciliation: OAUG/Collaborate & UKOUG
2010: Can We Actually Reconcile Project MFG to Inventory, WIP, Projects & G/L? What Was I Thinking?
2011: 60 Inventory Orgs? 6 Ledgers? No Worries, Reconcile Your Inventory With Ease!
2014: Reconcile Your Inventory to G/L Balances With Ease, From 1 to 1,000 Inventory Organizations!
2017: Managing Oracle EBS Reconciliation in Manufacturing and Distribution Organizations

Period Close: OAUG/Collaborate & UKOUG
2016: How to Manage the Inventory and Manufacturing Period Close and Remain Sane...

Profit in Inventory Solutions: OAUG/Collaborate
2010: Does Rel. 12 Solve Global Inter-Company Issues for Multiple Ledgers, Profit in Inventory and COGS?
2018: INTL: Cloud and EBS Costing, You Can Track & Eliminate Profit in Inventory (And Still Have a Life!)

Transaction Interfaces for Period Close: OAUG/Collaborate
2012: Egads! How in the Dickens Do I Handle Those Month-End Interfaces? (And Why Can’t I Close My Books)
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Learning Points

[0 Did Cloud Costing Really Change?

1 What is New and What is the Same?

[0 Compare Oracle EBS to Cloud Costing

[0 Learn about the Setup Steps

RE

COLLABORATE



Agenda

Cost Setups
Compare Oracle EBS with Oracle Cloud Costing
Cost Organizations
Cost Org Data Access
Cost Books and Cost Org Relationships
Valuation Structure
Cost Elements
Cost Component Mappings
Cost Profiles
Default Cost Profiles
Item Cost Profiles
Valuation Units
Expense Pools
Cost Scenarios
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What is the Cloud?

Sunday October 21, 2012
DILBERT

(I NEED YOU TO |
CLOUDWASH OUR
| SOFTWARE., |

| WE DON'T CARE WHAT
SMART PEOPLE THINK.
THERE ARENT THAT
MANY OF THEM,

MOVE SOME OF ITS
FUNCTIONS ONTO THE
1z INTERNET. BUT CALL

(| THE INTERNET A CLOUD. |

{2

LWJE ONLY NEED TO

CONVINCE OUR DUMB
CUSTOMERS.

DUMB PEOPLE

BELIEVE ANYTHING.

[ MO ONE WILL TAKE
US SERIOUSLY UNLESS
LJERE DOING SOME—
THING IN THE CLOUD.

DO YOU BELIEVE T
MOVED OUR SOFT-—
WARE TO THE CLOUD
YESTERDAY?

5 afl Adamas, Inc. T by Undeessl Liclick

[ WILL PEOPLE TAKE US |

L0 8 &
BY SCOTT ADAMS

SERIOUSLY IF WE MAKE
TECHNOLOGY DECISIONS
BASED ON JARGOMN?
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Cloud Costing Comparison and
Setup:

Compare Oracle EBS with
Oracle Cloud Costing




Oracle Cloud Costing Overview

[0 Costing by Inventory Organization R12 Discrete Costing

General Ledger

= Every org has its own Costing Method:

° FIFO Legal Entity

‘ LIFO Operating Unit

© Average Inventory Org Global 7‘I’he C:gz)a;SOé%zan be
(0] izati T

- Standard (1tom Mastor

* Periodic .

Item Costs ~ —>f Inve_n tory 1 | Invent.ory
= COStS held by COSt Type Organization Location
= Only Five Cost Elements
= Average/LIFO/FIFO use an AvgRates \ \ :

FG STORES MRB
Cost Type for Resource & Overhead Rates Subinventory | | Subinventory | | Subinventory

AN COLLABORATE
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Oracle Cloud Costing Overview (Continued)

R12 Process Costing

R12 Periodic Costing

General Ledger

Legal Entity

General Ledger

Operating Unit

Cost Master Organization — Costs by Fiscal Policy

The Global Org can be

Fiscal Policies Global | across OUs
by Legal Entity Organization
(Item Master)
Cost Calendars i
Cost Information | Inventory |3 Inventory
(Cost Master) ~|  Organization Location
|
|

v ‘ '

FG STORES MRB
Subinventory Subinventory Subinventory

Legal Entity

Operating Unit

Global
Organization
(Item Master)

The Global Org can be
across OUs

PAC Cost Group
v ‘ v
Inventory Inventory Inventory
Organization Organization Organization
(Standard) (Standard) (Average)
Cost Group 1 Cost Group 2 Cost Group 3

Slide 11
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Oracle Cloud Costing Overview (Continued)

Costing by Inventory Item Cloud Costing — 18C

General Ledger

Every item has its own Costing Method

Legal Entity
Cloud Costing Methods: oot Contor
Actual (FIFO) T Reteroncebamset [ cea
| | Organization
Perpetual Average | Cost Book and Cost Organization | (item ll/laster)
| |
Standard : c PN Cost ! o Inventory
: 8 B Organization | Organization
Labor (Resource) and Overhead Rates | i e—
|
always at Standard i v l
. . : Cost Profile :
Only supports Discrete Costing | [ Valustion || Cost || outpories] | | ,
(Process Costing 2019 or 2020?) | K e tems
: Valuation Cost Cost :
: Units Components Methods :
\ - _—_—_—__!

A'D\ COLLABORATE
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Oracle Cloud Costing Overview (Continued)

Cloud Costing — 18C
Costing by Cost Organization 5

One or more inventory organizations General Ledger
may share the same costs in a Cost Legal Entity
Organization (similar to OPM Fiscal Profit Center
Policies) | ReferonceDataset L | oneaton
| |
Costing by Cost Book i Cost Book and Cost Organization i (tem ll/laster)
. . |
May have multiple cost representations | coutmook ey Cost |, Inventory
. | Organization | Organization
for your transactions | i
. |
Only one flows to each Primary Ledger | v i
| Cost Profile
o o | |
Additional Cost B.ooks f(?r Secondary [t o Coupots | ,
Ledgers or Cost Simulations | i i > ltems
: Valuation Cost Cost :
| Units Components Methods :
|
e ———————

r{ A COLLABORATE
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R12 Comparison to Cloud Costing

Cloud Costing Ri2 - R12-OPM Description
Discrete

Reference Data Sets N/A N/A Grouping of common attributes or controls across modules, with seeded reference sets Common and
Enterprise. In order to use a Reference Data Set it must be assigned to a User. Cost Profiles, Valuation
Structures and Cost Elements are attached to Reference Data Sets.

Inventory Same Same Cloud inventory has one or more specially assigned non-transactional “Item Master” inventory orgs, as well

Organization as transactional inventory orgs. To be costed an Inventory Organization must belong to a Cost Organization.

Cost Organization N/A Cost Master | A grouping of inventory organizations. You can have one Cost Organization to Inventory Organization or
Cost Organization to many Inventory Organizations. Or even have many Cost Organizations, but each having
different Inventory Organizations.

Cost Book N/A N/A A representation of your costs and costing results. One set of costs go to your G/L, while you may have other
Cost Books in a different currency, or another one for management/Ops reporting (Lean Accounting or Value
Stream Reporting for example). Cost Books are assigned to Cost Organizations, and allows you to specify
whether Accounting entries will be created in the Cost Book and what type of Period-End Valuation controls
you want to use.

Cost Method Std, Avg, Standard, As of R13D (2017)/R18 (2018), with Cloud Costing you may use Standard, Average or Actual (FIFO) Cost

(Std, Avg, FIFO) LIFO, FIFO, Averageand | Methods. Cloud Costing does not have Periodic Costing and currently does not support Process Costing.

Periodic Lot Costing
Cost Scenario Kinda like a Kinda like a Use this to set up your “AvgRates” labor (resource) and overhead rates, or, your standard costs labor,
Cost Type Cost Type overhead and item costs. However, the Cost Scenario works very differently from Cost Types as once you

“Update Standard Costs” or publish your costs, you CANNOT REUSE THE COST SCENARIO. It
becomes un-editable, in fact you cannot see it in your list of values, for example, when trying to enter more
labor (resource) rates. Very frustrating.

A COLLABORATE
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R12 Comparison to Cloud Costing (Continued)

Cloud Costing Ri2 - R12-OPM Description
Discrete

Cost Profile N/A Fiscal Policy | Combination of your Valuation Structure, Cost Elements and Cost Policies. With Cloud Costing you set up
your Cost Profile and either individually or by using the Default Cost Profiles, assign the Cost Profile directly to
your items. Which means each item may have a different Costing Method.

Default Cost N/A N/A There are separate Default Cost Profiles for Asset, Expense and Consigned items. And you can default by

Profiles Inventory Organization or by Item Category.

Valuation N/A N/A How granular you wish to record and track the item costs. In Cloud Costing you can cost your items by Cost

Structure and Organization, Inventory Organizations, Subinventories,Grade, Lot or Serial. When you assign a Valuation

Units Structure to specific costing entities (inventory orgs, subinventories, items, etc.) you are assigning the
Valuation Unit to a Valuation Structure.

Cost Element Only five Only five For Cloud Costing, item costs are by Cost Element, but, the inventory, WIP, receipt and COGS accounting
entries are NOT recorded by Cost Element. Cloud Costing has five Cost Element Types: Material, Overhead,
Resource, Adjustment and Profit in Inventory and you can set up any number of Cost Elements.

Cost Policies N/A N/A Combination of your Costing Method, Costing Unit of Measure, and policies for handling negative inventory,
partial completions and scrap.

Analysis Groups N/A Similar Cloud Costing uses these Cost Element Analysis Groups for reporting purposes.

Cost Component N/A N/A Cloud Costing only uses these for Source Systems and for user-defined Cost Elements, such as purchase order
cost components (PO Price, Freight, Tax, IPV), Inter-Organization Transfers and Miscellaneous Transactions.

N/A Sub- Cost Sub-Elements do not appear to exist in Cloud Costing. But there are separate Overhead Pools and Overhead
Elements Components Absorption Rules in Cloud Costing for Inventory Costing as well as Resources and Resource Overheads for

Manufacturing.

A COLLABORATE
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Oracle Fusion General Concepts — Separation of Duties

[0 Main or Landing Page For Everyday Tasks 1 Setup Tasks for Analysts and Power Users

Setup: Manufacturing and Supply Chain Materials Management (v =

SO
» ougVoiz

Functional Areas  Change Feature Optin  >carch Tasks
Share thoughts with your colleagues.. * ltems hored n ~ Cost Accounting
0 0 0 i i .
e i [ | = . Carriers and Transit Times [ ~ ] View w Format w Freeze I Detach
o e Catalogs shared (D Task
@ VyFiags Al E Inventory Management = (I (Ersiy R RERE
o Manage Costing Lookups
Receiving Shared n
Manage Costing Descriptive Flexfields
* Shipping =

Manage Cost Organizations
Receipt Accounting shared (B2D

Manage Cost Organization Data Access for Users

* .
Cost Accounting % ED
= Manage Cost Books

x .
Cost and Profit Pl
ostand o anning ﬂ Manage Cost Organization Relationships

Landed Cost Management [ ~ ] Manage Cost Analysis Groups

6*5 COLLABORATE19
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Oracle Fusion General Concepts — Everyday Tasks

[0 Everyday Tasks for Cost Accounting

Cost and Profit Planning
» Manage Cost Scenarios

» Manage Standard Costs
» Manage Standard Cost Import Exceptions
» Manage Resource Rates
» Manage Overhead Rates
» View Rolled-up Costs
» \iew Scenario Exceptions
» Compare Standard Costs
ltem Costs
= Review ltem Cosis
» Analyze Standard Purchase Cost Variances
» Manage Accounting Overhead Rules

» Manage Cost Adjustment

Cost Processing
» Create Cost Accounting Distributions

» Manage Cost Accounting Periods

» Review and Approve [tem Cost Profiles
» Review Cost Accounting Processes

= Review Work Order Costs

» Review Maintenance Work Order Costs
» Analyze Product Gross Margins

» Review Cost Accounting Distributions

» Review Inventory Valuation

Accounting
» Create Accounting

* Review Journal Entries

[0 Everyday Tasks for Receipt Accounting

Accrual Processing
» Create Receipt Accounting Distributions

» Create Uninvoiced Receipt Accruals

» Review Receipt Accounting Distributions

Accrual Clearing
s Clear Receipt Accrual Balances

» Manage Accrual Clearing Rules

» Adjust Receipt Accrual Balances
Accrual Reconciliation

» Match Receipt Accruals

» Audit Receipt Accrual Clearing Balances
Accounting

s Create Accounting

» Review Journal Entries

Landed Costs
» Manage Trade Operations

» Review Purchase Orders for Landed Cost
» Manage Charge Invoice Associations

» Manage Landed CostProcesses

» Review Landed Cost Processes

» Manage Trade Operation Templates

» Reconcile Landed Cost Charges

* View tem Landed Cost

» Analyze Landed Cost Charges

» Analyze Landed Cost Variances

» Capture Trade Operation Charges in Spreadsheet

Slide 18
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Costing Flow Example

PO Receipts into Storeroom Charging Work Orders Ledger Accounts

@
o Ledger

Accounts

oy Receive Into
yd; Storeroom

Supplier Work Order

Sends Parts g
Labor and Admin and
Overhead Supervisors
Resources

At COLLABORATE S
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Discrete Costing Transaction Flows Overview

PO Issue Charging
Transaction Area Receipt Components Resources
Storeroom Increase in Decrease in
quantity quantity
Increase in Increase in
Work Order quantity hours
1) Receiving Cost Processor 1) Inventory Cost Processor 1) Resource Cost Processor
Background 2) Inventory Cost Processor 2) Run Create Accounting 2) Run Create Accounting

COStmg Processes 3) Run Create Accounting

) Increase in Decrease in
Inventory Costing value value
. Increase in Increase in
Work Order Costing —_ -
A\ COLLABORATE 9
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Cloud Costing Transaction Flows Overview

PO Issue Charging
Transaction Area Receipt Components Resources
Storeroom Increase in Decrease in
quantity quantity
Increase in Increase in
Work Order quantity hours
1) Transfer Receiving Costs 1) Transfer Inventory Costs 1) Transfer Production Costs
Background 2) Transfer Inventory Costs 2) Transfer Production Costs = |2) Create Cost Distributions
Costing Processes | 3) Create Receipt Distributions | 3) Create Cost Distributions 3) Run Create Accounting
4) Create Cost Distributions 4) Run Create Accounting

52 Run Create Accounting

) Increase in Decrease in
Inventory Costing value value
. Increase in Increase in
Work Order Costing —_ -
AN\ COLLABORATE 19
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Cloud Costing Setups

1 Setup Menu

Setup and
Maintenance

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting

Manage Cost Manage Cost Define Cost Manage
Define Users Organizations Elements Profiles Overhead
and User v ¥ ¥ 1Cost
Access \ Manage Cost Manage Cost Manage e
Organization Analysis Default Cost
- Data Access Groups Profiles v
Define * Set Up
Reference l l Subledger
Sets and Manage Cost Manage Cost LAFLELE Accounting
Assign Users Books Component Cost Profiles
l Mappings l v
v Assi Manage
gn .
BiRtE S Okt Manage Default Cost Mapping Sets
Org : .
X . Valuation Profiles to
Relationships
Structures Items
; ! !
Assign Cost
Books to Manage Manage
Inventory Valuation Overhead
Orgs Units Cost Pools

Il GokLonciiue

Slide 23
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Cloud Costing Setups: Cost Organizations

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Cost Organizations

[J Open and Close
Periods by Cost oo
Organization

1 Share Costs

= vision

Manage Cost Organizations

4 Search

Setup: Manufacturing and Supply Chain Materials Management '~

Name Starts with |v| Cost Organization Code Starts with t i
Search Tasks S '

Functional Areas Change Feature Opt In

Status Equals ! j |: Legal Entity Name Starts with E!

2! Cost Accounting

Receiving Shared

Search Reset Save...

View w Forma Freeze

* Shipping < >

Search Results

Receipt Accounting Shared

Manage Cost Organizations . . " R
* Cost Accounting o g d Actions v View w <= 4 | Detach

Manage Cost Organization Data Access.

* Cost and Profit Planning Name Cost Organization Code Legal Entity Name Status

Us-001

US Operations US1 Legal Entity

UK Operations UK-001 UK Legal Entity

FR Operations FR-001 France Legal Entity

CH-001

CN Operations China Legal Entity

USHC-001

USHC Operations Healthcare US Legal Entity

A

Faw TECHNCLOGY AND APPLICATIONS. FORJM
FOR THE ORACLE COMMUNITY
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Cloud Costing Setups: Cost Organization Data Access

1 Need Access to Cost
Organizations

Functional Areas

Change Feature Opt In

Setup: Manufacturing and Supply Chain Materials Management '~

Receiving
* Shipping
Receipt Accounting

* Cost Accounting

* Cost and Profit Planning

Shared

Shared

~

Setup and
Maintenance

Search Tasks

Cost Accounting

View w Format w

Manage Cost Organization Data Access...

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Cost Organization Data Access for Users

= vision

Manage Data Access for Users

O Users without Data Access @ Users with Data Access

Security Context Cost organization

4 Search

Search Results

Actions w View w

)

User Name

TIMOTHY.LEVINE
TIMOTHY.LEVINE
TIMOTHY.LEVINE

TIMOTHY.LEVINE

+

F

7 Detach

** User Name TIMOTHY.LEVINE A

Authorize Additional Data Access

Role

Cost Accountant

Cost Accountant

Cost Accountant

Cost Accountant

Have to click here if you
already have Data Access

s Either field is required

** Role Cost Accountant

Security Context
Cost organization
Cost organization
Cost organization

Cost organization

Slide 25

SCM_IMPL ~

Saved Search Default Search 'q

* At least one is required

Reset Save...

Security Context Value

UK Operations

US Operations

CN Operations

FR Operations
AN\ COLLABORATE 9
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Cloud Costing Setups: Cost Organization Data Access

0 Can S h f Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
o Management => Cost Accounting => Manage Cost Organization Data Access for Users
Data ACCeSS Mall!lepnance

=V I S |O n Q fy U SCM_IMPL ~

Manage Data Access for Users Drop down list

O Users without Data Access @ Users with Data Access

Security Contex‘tg Cost organization

All
Asset book
Business unit
Control budget

** g Costorganization ** Role Cost Accountant
Data access set
Intercompany organization
Inwentory organization
ltem organization

Search Results Ledger

Manufacturing plant

Actions w View w Project organization clagsification thorize Additional Data Access
Reference data set

4 Search Saved Search Default Search v

** At least one is required

)

User Name Role Security Context Security Context Value
TIMOTHY_LEWVIME Cost Accountant Cost organization UK Operations
TIMOTHY.LEVIME Cost Accountant Cost organization US Operations

TIMOTHY.LEWIME Cost Accountant Cost organization CN Operations

TIMOTHY.LEWINE Cost Accountant Cost organization FR Operations

AN\ COLLABORATE 9
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Cost Organizations Access Example :

] Partition Access by Cost Organization

can also access...

1 Reference Data Sets Controls Access to:

» Cost Elements

Cost Component Mappings

= Valuation Structures

= Cost Profiles

can also access...

-

has access to ... l

~

l has access to

v
UK US Cost Japan
Cost Org Org Cost Org
v v v v v A 4 v A4 v \ 4
Costing for Costing for Costing for Costing Costing Costing Costing Costing for Costing for Costing for
Leeds London Birmingham for SFO for Dallas for Boston for Miami Osaka Tokyo Yokohama
Inventory Org Inventory Org Inventory Org K Org Org Org Org / Inventory Org Inventory Org Inventory Org
ﬂ'\ COLLABORATE
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Cloud Costing Setups: Cost Organization Data Access

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
= Add Access to Management => Cost Accounting => Manage Cost Organization Data Access for Users
Reference Data Sets "

SCM_IMPL

] Controls Access to: Reference Data
Manage Data Access for Users Set m

= Cost Elements
" COSt Component Mappings Security Context Reference data set e

O Users without Data Access @ Users with Data Access

4 Search Saved Search Default Search |+

= Valuation Structures

** At least one is required

" COSt PI‘OfileS ** User Name TIMOTHY.LEVINE v ** Role -

Search Reset  Save..

Search Results

Actions v View v o i=| Detach Authorize Additional Data Access Seeded Set IdS

.
User Name Role Security Context Security Context Value
TIMOTHY.LEVINE Cost Accountant Reference data set Enterprise Set
TIMOTHY.LEVINE Supply Chain Controller Reference data set Common Set
TIMOTHY . LEVINE Cost Accountant Reference data set Common Set
TIMOTHY.LEVINE Supply Chain Controller Reference data set Enterprise Set

ﬂ*-) COLLABORATE 19
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Cloud Costing Setups: Cost Organization Data Access

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
D Add Data ACCGSS Management => Cost Accounting => Manage Cost Organization Data Access

Setup and
Maintenance

SCM_IMPL -
Manage Data Access for Users
O Uzers without Data Access @ Users with Data Access
Security Context Reference data set
4 Search Saved Search Default Search
Create Data Access for Users quired
** User Name TIMOTHY.LEVINE .
+ B/
* User Name * Role * Security * Security Context Value =
Context
Search Resulis
TIMOTHY.LE w v v
View w & i='" Detach Authorize Additional Data Ag
Asset book
Business unit
Create Control budget
Cost organization e Cancel
Export to Excel Data access set
Role Intercompany organization
Revoke Data Access Assignments Inventory organization
Cost Accountant Ledger

Manufacturing plant
Project organization classification

Reference data set
ﬁ?‘ COLLABORATE 19
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Cloud Costing Setups: Manage Cost Books

. Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
D Deflne COSt BOOkS Management => Cost Accounting => Manage Cost Books

Setup and
Maintenance

= ViS |On Q M [F scmme

Setup: Manufacturing and Supply Chain Materials Management [= i
. . +
o (@) PS5 :
_ i SCM_IMPL ~
Functional Areas Change Feature Opt In e Tk — V I S I 0 n
FELEIVINTY Shared Wk 7 .
Cost Accounting Manage Cost Books Save and Close
* Shipping =
View v Format » Freeze
Receipt Accounti ared |
eceipt Accounting shared (B2 7 4 Search Saved Search Al Cost Books ||
* Cost Accounting o EB ; . - e
MansflfCost Organization Data Access| Cost Book Startz with |z| Description Starts with Lv |
* Cost and Profit Planning [ ~ ] o i
; Manage Cost Books Search  Reset  Save.. Add Fields ¥  Reorder
* Landed Cost Management ﬂ
Manage Cost Organization Relationships] £ >
Search Results
Actions v View » Format v < 3 lu’ Detach Wrap
*Cost Book Description Attachments
-
b 001-Seattle 001-Seattle Hone s
b 002-Atlanta 002-Atlanta Mone s
» 003-Chicago 003-Chicago Mone s
}  004-Boise 004-Boize Mone s
"A COLLABORATE 19
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Cloud Costing Setups: Manage Cost Organization Relationships

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Cost Organization Relationships => Set
Assignments

1 Define Cost Org
Relationships s

= VISIOﬂ Q @ [ sommee

Setup: Manufacturing and Supply Chain Materials Management [~] &

Functional Areas Change Festure Opt1n | S6arch Tasks Manage Accounting Cost Organization Relationships
meLsvi y Ehared kA
. Cost Accounting b Search Advanced | Saved Search Al Cost Organizations v |
Shipping ﬂ -
View v Format v Freeze
Task b
* Cost Accounting o B Actions w View w Format w < 3 Freeze [=] Detach Wrap
Manage Cost Books Cost
* Cost and Profit Planning = " e S 2 * Item Validation Standard Cost
Manage Cost Organization Relationships Cost Organization g;%:mmm" Legal Entity Name O i Approval
* Landed Cost Management =
ell L L CH Operations CN-001 China Legal Entity Operations —
FR Operations FR-001 France Legal Entity Operations A
UK Operations UK-001 UK Legal Entity Operations s
US Operations Us-o001 US1 Legal Entity Operations |:|
R f D t USHC Operations USHC-001 Healthcare US Legal ... Operations .

Columns Hidden 2

Set Assignments

4 US Operations: Relationships

Set Assignments | Inventory Organizations  Cost Books

Actions w View v 4 3¢ [=7 Detach

* Reference Data * Reference Data Set Reference Data Set
Object Name Code
. Cost Planning Setup Enterprise Set ENTERPRISE
Slide 31
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Cloud Costing Setups: Manage Cost Organization Relationships
= vision T

-
. 5

= Tnd Lo SCM_IMPL -~

D Deflne COSt Org Manage Accounting Cost Organization Relationships
Relationships ~
b Search Advanced Saved Search Al Cost Organizations |w
Search Results: Cost Organizations
Actions w View w Format w o 3 Freeze [z} Detach Wrap
aintinance
Cost
K * Cost Organization Organization Legal Entity Name Sta:;:[r:v(;:)st
Menu Path: Setup and Maintenance => Code
Manufactul’lng and Supply Chaln Materlals CN Operations CN-001 China Legal Entity Operations =
. FRO il FR-001 Fi Legal Entity o] ti =
Management => Cost Accounting => e B perene
. . . . UK Operations UK-001 UK Legal Entity Operations —
Manage Cost Organization Relationships =>
| t o . t' US Operations Us-o001 US1 Legal Entity Operations |:|
nventor rganizations
y g USHC Operations USHC-001 Healthcare US Legal ...  Operations =
Columns Hidden 2
4 US Operations: Relationships
SetA it W Cost Books
Multiple inventory Actions v View v Formatw < 12 Detach Wrap
orgs belong to one Cost * Name "'a"“;ah';“““"g g::;?r::::ﬁn ;;ged“ St ffective End Date  Attachments Status
Organlzatlon b Boise v US1 Business Unt  1/1/01 e Iy None & Actve [~
b Dallas v US1 Business Unt 1/1/01 Nong =j= Active
b Atlanta v US1 Business Unit  1/1/13 None =f= Active
b Seattle Maintenance ~ US1 Business Unit 1/1/01 None == Active COLLABORATE “ \.?
Shde 32 b Seattle v US1 Business Unt 11113 Nong =j= Active -E‘c;;?{a‘:?nl‘l:“lf:"‘?us et
v




Cloud Costing Setups: Manage Cost Organization Relationships

1 Define Cost Org
Relationships

Setup and
Maintenance

Menu Path: Setup and Maintenance =>
Manufacturing and Supply Chain Materials
Management => Cost Accounting =>
Manage Cost Organization Relationships =>
Cost Books

Only one Cost Book
flows to the Primary
Ledger

Slide 33

= VISIONn
Manage Accounting Cost Organization Relationships
P Search

Search Results: Cost Organizations

ol

Advanced  Saved Search All Cost Organizations |~

Q f SCM_IMPL

Actions w View w Format w o 3 Freeze [g] Detach Wrap
* Cost Organization g::s;nimtion Legal Entity Name * Item Validation Slandeos]
9 g €9 Organization Approval
CMe ..................................
CN Operations. CN-001 China Legal Entity Operations —
FR Operations FR-001 France Legal Entity Operations =
UK Operations UK-001 UK Legal Entity Operations =
US Operations. us-o001 US1 Legal Entity Operations D
USHC Operations USHC-001 Healthcare US Legal ...  Operations =
Columns Hidden 2
4 US Operations™ Relationships
o .
_ = Policies by Cost Book
Set Assignments  Inventory Organizations | Cost Books
Actions w View v Formatw S X Freeze Irap
= Accounting First Opened h
Cost Book Ledger Primary Book Currency Calendar Period E
US Operations uso AccountingMhy™ 01-13 L)
M001-Seattle uso AccountingMhy™" 0117
FTe
Financial US Primary Ledger (] uso AccountingMiy™y ] 01-13 \BORATE |1Q
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Cloud Costing Setups: Manage Cost Analysis Groups

[J Optional,
for Reporting

Setup: Manufacturing and Supply Chain Materials Managemen

Functional Areas

INVENTory Management
Receiving

* Shipping
Receipt Accounting

* Cost Accounting

* Cost and Profit Planning

Change Feature Opt In

>

Maintenance

Search Tasks

Cost Accounting

View w Format w

Manage Valuation Structures

Slide 34

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Cost Analysis Groups

= vision

4 Search

Analysis Group Starts with

Search Results
Actions » View w Format w

* Analysis Group
»  ariable
¥ Variabilty Group
*  Expense Type Group
¢ Value Added Group

L4 Non Value Added Group

A Variable: Analysis Codes
Actions » View w Format w

* Analysis Code
Mo data to display.

Manage Cost Analysis Groups

+ X Wrap
Description
Variable
“ariabiity Group
Expense Type Group

Value Added Group

MNon Value Added Group

L Wrap

Description

Description Starts with

K3

r L~

Advanced Saved Search Al Analysis Groups l:-

SCM_IMPL -

Search Reset Save...

>

Attachments
None sj
None
None s
None sj

None ==

Defmill
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Cloud Costing Setups: Manage Valuation Structures

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Valuation Structures

1 How to Cost
“Asset” Items —
= vision

Setup: Manufacturing and Supply Chain Materials Management

L SCM_IMPL

vision

Manage Valuation Structures m

" ]l
Advanced Saved 5 h Al Valuation Struct

Functional Areas Change Feature Opt In Seaiciyasks 4 search Quan ed seard slustion Strustures |:_l
Smppiny L~ Valuation Structure Set Equals ‘vi L Valuation Structure Code Starts with Iv
Cost Accounting == =

Receipt Accounting sharea IR Valuation Structure Type Equals Description Starts with
View » Format » =
* Cost Accounting o ED Search  Reset = Save..

Task

* Cost and Profit Planning [~ ] Search Results
Marjille Cost Analysis Groups:
* Landed Cost Management = Actions v View w Formatw S Freeze
* Intrastat Reporting =3 Valuation .
Manage Cost Elements Valuation Dt
structure g 4 Type Description Attachments

Set

Auto

Common Set

Consignment

Owner Type, Owner, Original Receipt

Inv Org-Asset ?CDmmnn Set  Asset Valuation Structure-Inv Org Cost Organization and Inventory Organization  Both auto and manual

Inv Org-Expense Common Set  Expense Waluation Structure-Inv Org Cost Organization and Inventory Organization Both auto and manual

Common Set  Asset Both auto and manual

InvOrg_Subinventory_Asset Inventory Subinventory Inventory Subinventory

InvOrg_Subinventory_Expense  Common Set  Expense Inventory Subinventory Inventory Subinventory Both auto and manual

<

Separate item costs by

inventory organization
4 Inv Org-Asset: Costing Attributes

‘iew w Format w Freeze

Sequence Costing Attribute

BORATE 19

O APPLICATIONS FORIM
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1 Cost organization No
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Cloud Costing Setups: Manage Valuation Structures

1 How to Cost
“Expense” Items .
= vision

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Valuation Structures

= vision

SCM_IMPL ~

Search Tasks

Functional Areas Change Feature Opt In

Suppiny -,
Cost Accounting
Receipt Accounting Shared ﬂ
View » Format w
* Cost Accounting L™ =

Task
* Cost and Profit Planning

* Landed Cost Management

* Intrastat Reporting
Manage Cost Elements

Separate item costs by
inventory organization,
use for Asset Items
(Maintenance)

Setup: Manufacturing and Supply Chain Materials Management =

Marjille Cost Analysis Groups:

Slide 36

Manage Valuation Structures ﬁ

4 Search Advanced = Saved Search Al Valuation Structures

Valuation Structure Set Equals

v Valuation Structure Code Starts with w|

Valuation Structure Type Equaks |v| Description Starts with

Search Reset Save...

Search Results

Actions v View w Formatw o & K Freeze Wrap
) Valation yation - )
Valuation Structure Code gg;uclure Structure Type Description Flexfield Structure Valuation Structure Mode  Attachments
Consignment Commen Set  Consigned Consignment Owner Type, Owner, Original Receipt Aute Mone
Inv Org-Asset Commen Set  Asset Valuation Structure-inv Org Cost Organization and Inventory Organization  Both auto and manual None
Inv Org-Expense Commen Set  Expense Valuation Structure-Ilnv Org Cost Or and Inventory Or Both auto and manual None
InvOrg_Subinventory_Asset .Cummun Set  Asset Inventery Subinventory Inventery Subinventory Both auto and manual Mone
InvOrg_Subinventory_Expense  Common Set  Expense Inventory Subinventory Inventory Subinventory Both auto and manual MNone
< >
4 Inv Org-Expense: Costing Attributes
View v Format w Freeze [z} Detach Wrap
Sequence Costing Attribute Required
1 Cost organization No
2 Inventery organization No

ABORATE 19
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Cloud Costing Setups: Manage Valuation Structures

1 How to Cost
“Consigned” Items
= vision

Setup and
Maintenance

Setup: Manufacturing and Supply Chain Materials Management =
Functional Areas Change Feature Opt In SEAICHTIZEXE
Smpping -,
Cost Accounting
Receipt Accounting shared B
View » Format w
* Cost Accounting L™ =
Task
* Cost and Profit Planning [~ ]
Marjille Cost Analysis Groups:
* Landed Cost Management n
* Intrastat Reporting =3
Manage Cost Elements

Separate item costs by
consignment owner and
receipt number

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Valuation Structures

= vision

Manage Valuation Structures

4 Search
Valuation Structure Set Equals L:J v
Valuation Structure Type Equals
/
Search Results
Actions ¥ View w Formatw 4 4 K Freeze Detach Wrap
Strucure  Valuaton Description
Set Structure Type
Consignment éCDmmDn Set  Consigned Consignment
Inv Org-Asset .Cummun Set  Asset Valuation Structure-inv Org
Inv Org-Expense Common Set  Expense Valuation Structure-inv Org
InvOrg_Subinventory_Asset Common Set  Asset Inventory Subinventory
InvOrg_Subinventory_Expense Common Set  Expense Inventory Subinventory

<

4 Consignment: Costing Attributes

View w Format w Freeze Wrap

Sequence Costing Attribute
1 Owner Type
2 Owner

3 Original Receipt Number

Valuation Structure Code Starts with

Description Starts with

Owner Type, Owner, Original Receipt

Cost Organization and Inventery Organization
Cost Organization and Inventery Organization
Inventery Subinventory

Inventery Subinventory

Search

Auto

Both auto and manual

Both auto and manual

Both auto and manual

Both auto and manual

SCM_IMPL -

Reset Save...

Attachments

None

None

None
Hone

Hone

Required
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Cloud Costing Setups: Manage Valuation Structures

0 How to Cost
by Subinventory
= vision

Setup: Manufacturing and Supply Chain Materials Management =

and
Maintenance

Search Tasks

Functional Areas Change Feature Opt In

Smppiny

L~
Cost Accounting
Receipt Accounting shared B
View » Format w
* Cost Accounting L™ =
Task
* Cost and Profit Planning [~ ]
Marjille Cost Analysis Groups:
* Landed Cost Management n
* Intrastat Reporting =3

Manage Cost Elements

Separate item costs by
Cost Org, Inventory Org
and Subinventory

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Valuation Structures

= VISIiOon
Manage Valuation Structures

4 Search
Valuation Structure Set Eguals

Valuation Structure Type Eguals

Search Results

Actions w View v Formatw < 3 Freeze Detach Wrap
Valuation Structure Code v el ype  Description
Set

Consignment Common Set  Consigned Consignment

Inv Org-Asset Common Set  Asset Valuation Structure-Inv Org
Inv Org-Expense Common Set  Expense Valuation Structure-Inv Org
InvOrg_Subinventory_Asset Common Set  Asset Inventory Subinventory
InvOrg_Subinventory_Expense . Common Set  Expense Inventory Subinventory

<

4 InvOrg_Subinventory_Asset: Costing Attributes

View w Format w Freeze Wrap

Sequence Costing Attribute
1 Cost organization
2 Inventory organization

3 Sub-inventory

Advanced Saved Search Al Valuation Structure:

Valuation Structure Code Starts with

Description Starts with

Hexfield Stricture

Owner Type, Owner, Original Receipt

Cost Organization and Inventory Organization
Cost Organization and Inventory Organization
Inventory Subinventory

Inventory Subinventory

Search

Maluation'Struchire Mode

Auto

Both auto and manual
Both auto and manual
Both auto and manual

Both auto and manual

o SCMLIMPL

Reset = Save..

Attachments

None
None
Nene
None

None

Required
No

No
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Cloud Costing Setups: Manage Cost Elements

. Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
D Deflne Your OWn Management => Cost Accounting = Manage Cost Elements
Cost Elements

= vision

Vv I S i on Q wm™ [P scmmev

Setup: Manufacturing and Supply Chain Materials Management [~/ &=
Functional Areas Changs Festurs Optln | 3927Ch Tasks Manage Cost Elements Save and Close
Cost Accounting
* Shipping =2 [
View w Format v \ 4 Search Advanced Saved Search All Cost Elements |::
Receipt Accounting shared - —
CostElement Starts with Iv Description Starts with iv
* Cost Accounting s ER =5 Gl
* Cost and Profit Planning = Search Reset Save...
* Landed Cost Management =
Manage Cost Component Mappinos Search Results
* lmbn b P m i -

Actions w View w Format w 3+ X Wrap

* Cost Element * Cost Element Set

* Cost Element Type Description Inventory Organization  Attachments

¥ IM-001 Common Set Proftt in inventory Internal Margin Pl Seattle None =f=

Define your own material,
material overheads, profit in "

MI_MOHO1 Common Set Material overhead MIMOHM Mone 4

inventory, etc.... cost elements
F IN-003 Common Set Profit in inventory Internal Margin PIl Chicage Mone ==
b IM-100 Common Set Profit in inventory Internal Margin PIl Manchester Mone o=

Everyone can use
these

AN\ COLLABORATE 19
Slide 39 L T



Cloud Costing Setups: Manage Cost Component Mappings

. Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
D TO Interface Wlth Management => Cost Accounting => Manage Cost Components

Setup and

External Cost

S = Vi S i on Q A F scwme
ources
Manage Cost Component Mappings save

. -
- VI S I O n P Search: Component Groups Saved Search Al Cost Component Groups |~

Setup: Manufacturing and Supply Chain Materials Management »| Search Results: Component Groups

Functional Areas Change Feature Opt In Seanch lazks SR YRRV, [omtiy % B i Detack i
*Code Name * Set Hame Description Attachments
* Shipping n & Cost Accounting »  Common Component Group Commen Component GroL  Common Set Mone 4
Receipt Accounting shared (DD View w Format w b MIComponet Group 1l Componet Group Commen Sat None o
* Cost Accou nting ®, Task » Enterprise Component Group Enterprise Component Gr. Enterprise Set None -I-

* Cost and Profit Planning Manage Cost Elements

* Landed Cost Management Manage Cost C !

4 Common Component Group: Mappings

* 3 Manage Cost Profies —eeeeeeee
Intrastat Reporting Cost Component Codes | Cost Elements

Actions v View » Format w + B &  Clear B Freeze Wrap

Not like the R12 Sub-Elements Costcomponents Destnaton Cost emants
Only used for interfacing from a Cost soes et Sthame * CostComponentCote  [COMPNN < CostEiement set *CostElement [T Eement
Source, like from Payables and IPV or Cosipbig  Enrrs S 14800 Resouce vteas ComonSe  RESOURCE OVERYE) w | Ovrond
from PO receipt transactions and the parERA

Cost Component Code “ITEM_PRICE” e e one ormon 52 emes

Predefined Common Set INVOICE_PRICE_VARIANCE Common Set PV Overhead
Predefined Common Set ITEM_PRICE Commen Set MATERIAL Material ‘
Shde 40 Predefined Commen Set TAX_EXCHANGE_RATE_VARIANCE Common Set TER Overhead s
<

>
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Cloud Costing Setups: Manage Cost Component Mappings

1 To Interface With

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Cost Components

External Cost S,
Sources

vision e

Manage Cost Component Mappings Save Ca
4 Search: Compeonent Groups Saved Search Al Cost Component Groups. :|
: ; : Code Equais D tion Equals
Setup: Manufacturing and Supply Chain Materials Management '*| = e e
Name Equals SetName Equals ,_v v
= Search Tasks -
Functional Areas Change Feature Opt In il ad e Eeenncilkes
A .
* Shipping [~ | Cost Accounting Search Results: Component Groups
Receipt Accounting sharea ) View w  Format w Freeze o Detach Aoy Veww Pomly 4 B X Virap
*Code Name * Set Name Description Attachments
* Cost Accountin °, Task He
¢ - n 14 Common Component Group Common Component Group  Common Set Mone 4
* g
Cost and Profit Planning [ ~ ] Manage Cost Elg » M Componet Group 141 Componet Group Common Set None o
* |anded Cost Management = Manage Cost C }  Enlerprise Component Group Enterprise Component G | Enlerprise Set None o=
* 2 Manage Cost Profies = z
Intrastat Reporting =
4 Enterprise Component Group: Mappings
Cost Component Codes | Cost Elements
Actons w View v Formaty < [H ¥ © clar 5 Freeze Wrap
l lsed for the Cost Rollup Cost Components Destination Cost Elements
. *
Cost plannln Soc“‘ Component . s(yame  * Cost Component Code Cost Component . ¢oqt flement Set * Cost Element Cos Elomen
urce Type Type
Cost planning Enterprise Set LABORO Resource overhead  Common Set RESOURCE OVERHEAD Overhead
Cost planning Enterprise Set MTL Material Enterprise Set Material Material
. Cost planning Enterprise Set  MACH Resource direct Enterprise Set Machine Resource A
Slide 41

Cost planning Enterprise Set MACHO Resource overhead  Enterprise Set Resource Overhead Overhead
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Cloud Costing Setups: Manage Cost Profiles

1 Cost Each Item

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Cost Profiles

Setup and
Maintenance

— by Cost Profile

Setup: Manufacturing and Supply Chain Materials Managemg

Search Tasks

Functional Areas Change Feature Opt In

* Shipping = Cost Accounting
Receipt Accounting Shared ﬂ
* Cost Accounting ° ED Task
* Cost and Profit Planning ﬂ Manage Cost Profies
* Landed Cost Management n Manage Default Cost Profiles
* |ntrastat Rennring o | Manage fem Cost Profiles

Need at least two:
1) Asset for valued Items

2) Expense for Expense
(EAM) Asset Items

SCN_IMPL -~

vision
Manage Cost Profiles

Search Advanced

Cost Profile Starts with

i Description Starts with B

Search Results

”
= SCM_IMPL

Saved Search All Cost Profiles V%

Search Reset Save..

Actions v View v Formaty 4 X Freeze Detach Wrap
Cost Profile Cost Profile Set Deseription Cost Method Valuation Structure ‘éﬂ'ﬂiﬁﬂ Propagate Cost o int Without Cost Referenced RMA Cost
Type

Standard-Expense  Common Set Standard Costing-Expense Standard cost Inv Org-Expense Expense - Use current average cost Average cost of original sales order
AverageCost-Exp...  Common Set Average Cost-Expense Perpetual average Inv Org-Expense Expense — Use current average cost Average cost of original sales order
ActualCost-Expense  Common Set Actual Cost-Expense Actual cost Inv Org-Expense Expense v Use first receipt layer cost Average cost of original sales order
Consignment Cost... Common Set Consignment Cost Profile Actual cost Consignment Consigned v Use first receipt layer cost Average cost of original sales order
AverageCost-Asset  Common Set Average Cost-Asset Perpetual average Inv Org-Asset Asset = Use current average cost Average cosl of original sales order
ActualCosi-Asset ‘Common Set Actual Cost-Asset Actual cost Inv Org-Asset Asset v Use first receipt layer cost Average cosl of original sales order
Standard-Asset Common Set Standard Costing-Asset Standard cost Inv Org-Asset Asset — Use current average cost Average cost of original sales order

Slide 42
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Cloud Costing Setups: Manage Cost Profiles (Continued)

[0 Cost Policies by
Cost Profile

Cost Profile

Standard-Expense
AverageCost-Exp-..
ActualCost-Expense
Consignment Cost..-

AverageCost-Asset

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials

Management => Cost Accounting => Manage Cost Profiles

Manienance
Cost Profile Set Description Cost Method 1 Structure
Common Set Standard Costing-Expense Standard cost Inv Org-Expense
Common Set Average Cost-Expense Perpetual average Inv Org-Expense
Common Set Actual Cost-Expense Actual cost Inv Org-Expense
Common Set Consignment Cost Profile Actual cost Consignment
Common Set Average Cost-Asset Perpetual average Inv Org-Asset
P ti .
oty hogae Depen Co Component g
Quantity Method R
Primary UOM  Always Firstin first ... Common Component Group
Primary UOM  Always First in first ... Common Component Group
Primary UOM  Always Firstin first ... Common Component Group
Primary UOM  To zero First in first ... Common Component Group
Primary UOM  Always First in first ... Common Component Group

Valuation
Structure
Type
Expense _
Expense _
Expense v
Consigned v
Asset -
Accounting

Distribution
Basis

Create
Accounting

At Zero Cost No

Receipt Without Cost

Referenced RMA Cost

Use current average cost
Use current average cost
Use first receipt layer cost
Use first receipt layer cost

Use current average cost

Provisional Completions

Value at standard cost
Value at perpetual average cost

Value at last actual cost

Value at perpetual average cost

Average cost of original sales order

Average cost of original sales order

Average cost of original sales order

Average cost of original sales order

Average cost of original sales order

Operation
Scrap
Accounting
Expense
Expense

Expense

Expense

Slide 43

Operation Scrap
Valuation

Value immediately ...
Value immediately -..

Value immediately ...

Value immediately -.-

é"‘ COLLABORAT

Attachments

None

Nane

None

Nane

Nane

AMDHAPPLICATIONS. FOR

TECHNOL
ak

E



Cloud Costing Setups: Manage Cost Profiles (Continued)

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Cost Profiles => (Edit) AverageCost-Asset

] Controls How You
Cost Transactions =

= VI Slon Q i SCM_IMPL ~

Edit Cost Profile: AverageCost-Asset [ cancel |
Cost Profile Set Common Set Additional Information &4 SCI'OH dOWIl to see Second half
Cost Profile  AverageCost-Asset Attachments None = Of the screen or UI
Description Average Cost-Asset h
Accounting
Cost Method Perpetual average Quantity Depletion Method  First in first out
Account Intravaluation Unit Work Order Valuation Rules
Always O
Transfers
Valuation Rules Provisional Completions Value at perpetual average cost Operation Scrap Valuation Value immediately and at work order close
Operation Scrap Accounting  Expense
Valuation Structure Code  Inv Org-Asset CostBy Primary UOM
Cost Structure
Valuation Structure Type Asset
Cost Component Mapping Group Common Component Group Analysis Mapping A4
Turn on or off accounting for Transaction Costing Rules
Sublnvento 3 tranSfers * Receipt Without Cost  Use current average cost |~ * Referenced RMA Cost Average cost of original sales order |~

Propagate Cost Adjustment

ﬂ*‘ COLLABORATE 19
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Cloud Costing Setups: Manage Default Cost Profiles

[ Assign Cost Profiles
To Your Items

[0 Defaulted at Creation

= vision

Setup: Manufacturing and Supply Chain Materials Managemen|

Setup and

4 Search
Functional Areas Change Feature Optin | S2roh Tasks e
Cost Organization Equals | %
* Shipping = Cost Accounting I _'
T sharet () View w Format -& Cost Book Equals v
* Cost Accounting o ED é'lask ‘b
* Cost and Profit Planning = Manage ClProfies <
* Landed Cost Management n Manage Default Cost Profiles. Sear(:h ReSultS
* Intrastat Reporting [ ~ ] émanage T ostiiant Actionz » View w Format w» + ,\ x
Cost Organization Cost Book
Can have a different Costing
MethOd fOI‘ EaCh Category US Operations Financial
But you can leave the Category s e
blank if you use the same US Operations Financial
COSting MethOd fOI‘ al]. items US Operations Financial

Maintenance

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Default Cost Profiles

= vision

Manage Default Cost Profiles

v
Freeze [z Detach Wrap
Category Name Asset Cost Profile

Computer Accessories
Computer Monitors
Computer Servers

Electronic Accessories

ActualCost-Asset

ActualCost-Asset

AverageCost-Asset

AverageCost-Asset

Q @ [ scmameLe

=]
Advanced @ Saved Search AllDefault Cost Profiles vI
- Category Name Eguals :v
Search Reset Save...
>
FIFO
Costing
cxpense Cost Profile Consigned Cost Profile g?:atn:rl:]
ActualCost-Expense Auto fa
ActualCost-Expense Auto
AverageCost-Expense Auto
AverageCost-Expense Auto

Average

Slide 45
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Cloud Costing Setups: Manage Valuation Units

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Valuation Units

1 How Item Costs are

Maintained
= vision vision

Setup: Manufacturing and Supply Chain Materials Manageme Manage Valuation Units

Search Tasks

Functional Areas Change Feature Opt In earch Saved Search Al Valuation Units

* Shipping Cost iecounting Search Results

=
. ) View w Format w .
Receipt Accounting = Actions v View w Format w + £ X Freeze Wrap

* Cost Accounting % EB Cost Valuation Valuation Valuation Flexfield

Organization 0t B0oK Structure Type  V2Uation Ut Description Structure Mode  Structure Attachments

* Cost and Profit Planning
US Operations Financial Inv Org-Asset Asset Usw-001-001 Automatically Created Auto COST_INV_ORG None
Manage Valuation Units

* Landed Cost Management

US Operations Financial Inw Org-Asset Asset US'-001-003 Automatically Created Auto COST_INV_ORG Hone

Manage Overhead Expense Pools

* Intrastat Reporting US Operations 002-Atlanta Inv Org-Asset Asset US\-001-001 Automatically Created Auto COST_INV_ORG None
Manage Overhead Cost Element Group|

US Operations Financial Inv Org-Asset Asset US\-001-002 Automatically Created Auto COST_INV_ORG MNone

US Operations US Operations Inv Org-Asset Asset US\-001-002 Automatically Created Auto COST_INV_ORG MNone

US Operations 002-Atlanta Inv Org-Asset Asset US\-001-003 Automatically Created Auto COST_INV_ORG MNone

<

The level of granularity 4 US\-001-001: Segment Values Value inventory valyatlon
for item COSting Actions v View w Format w X Freeze Wrap reports and transaCtlons by
Account Code Valuation Unit
I Cost Organization-Inventory Organization US\-001-001

AN\ COLLABORATE 19
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Cloud Costing Setups: Manage Overhead Expense Pools

1 SLA Uses Expense
Pools for Account
Assignment

Setup: Manufacturing and Supply Chain Materials Management =

Search Tasks

Functional Areas Change Feature Opt In

Receiving shared K Cost Accounting
* Shipping = View w Formal v Fre
Receipt Accounting shares I Task
* Cost Accounting o BB Manage Vjlltion Units
* Cost and Profit Planning =3 Manage Overhead Expense Fools
* Landed Cost Management = (age Overhead Cost Element G
* ntrastat Reporting ”~ Manage Subledger Application
Badly named, should be

“Manage Expense Pools”

For both Overhead and Resource
Expense Pools, have to define Expense
Pools before defining Resource or
Overhead Rates

Setup and
Maintenance

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost and Profit Planning => Manage Overhead Expense Pools

vision

Manage Expense Pools

4 Search
Code Equals
Name Eguals

Description Eguals

Search Results
Actions w View v Format w
* Code Name

UK_DISTRIBUTION

UK_ELECTRIC
UK_GAS

UK_WATER

+ B X

Description

Freeze

Outbound Freight

Electric

Gas

Water

=" Detach
* Set Name
Enterprise Set
Enterprise Set
Enterprise Set

Enterprise Set

Set Hame Equals

Wrap

Inactive Equals

Inactive

Q m [ scmamee

Basic Saved Search Application Default |~ |
~] v
= ol
Search Reset Save... Add Fields ¥ Reorder
Additional Information Attachments

~

None =

None ==

None =

None ==

SR U
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Cloud Costing Setups: Manage Overhead Cost Element Groups

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Overhead Cost Element Groups

] Determines the
“Base” for the ——
Overhead calculation

= ViSion Q mr [F scmampLe

Manage Overhead Cost Element Groups Save and Close
Setup: Manufacturing and Supply Chain Materials Management ! &=
4 Search Saved Search  AllElmsnt Groups |~ |
Functional Areas Change Feature Optin | S°27Ch Tasks | |
~ Shipping =2 . Cost Organization Equals ] v Group Name  Starts with [+
Cost Accounting = e
Receipt Accounting shares (D Search  Reset  Save.. Add Fields ¥ Reorder
View w Format v
.
e Search Results Material overhead example
* Cost and Proftt Planning = i o}
—_— Actions w View v Formatw o 3 Freeze [z} Detach Wrap
* Landed Cost Management = * Cost
Manage Overhead Cost Element Groups Organization * Group Name  Description Inactive System Defined Additional Information Attachments
flrestat Reporting e WManage Subledger Application =
All Material Group Group of cost elements of element type Material forming part of the transaction cost S Yes MNone +
Manufacturing Haster Data =3 Update Subledger Application Options
All Transaction Cost  Group of cost elements with the exception of cost elements of element type Dverhead forming part of the transacti... — Yes None o=
US Operations US_TRANSACTI US Operations-Transaction Cost Element: |:| No Mone ==
US Operations. US_MATERIAL US Operations-Material Cost Elements. O No Hone =f=
UK Operations UK_MATERIAL UK Operations_Material Cost Elements |:| No Hone sf=
UK Operations UK_TRANSACTI UK Operations-Transaction Cost Element: O No None o

Resource overhead example

AN\ COLLABORATE 19
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Cloud Costing Setups: Cost Scenarios

1 Once Published You

Setup and
Maintenance

Menu Path: Costing => Cost Accounting => (Tasks) Manage Cost Scenarios

Cannot Make Any
Changes to Your
Cost Scenario!

= vision

Cost Oraanization All

= vision

Manage Cost Scenarios X

Cost Accounting

SCM_IMPL -~ [E]

After entering item costs (for standard costing),

labor (resource) and overhead rates (for any cost

Manage Cost Scenarios

P Search

Search Results

View w 4+ & % F © clear FEv 5 Detach
Scenario Cost Organization Cost Book Effective Date  Scenario Type
Mfg_Update US Operations Financial 1/4/18 Regular items
New Work Definitions ~ US Operations Financial 11817 Reqular items
Qulside Processing US Operations Financial /217 Regular items

Advanc.

State
Costs Published 53
Costs Published 53

Costs Published 54

method) you have to publish your costs

©
]
©

"~ Application Default |~

Status
Completed Successfully
Completed Successfully

Completed Successfully

Click here

SCM_IMPL ~

Cost and Profit Planning
« Manage Cost Scenarios
« Manage Standard Costs

« Manage Standard Cost Im

« Manage Resource Rates

Last Cost Roil........

CPS_Baseline_0! III = Manage Overhead Rates
[

= View Rolled-up Costs
® 3 RolledUp

* View Scenario Exceptions
« Compare Standard Costs

Manage Standard Costs

Manage Resource Rates

Badly
named!

Manage Overhead Rates

Roll up Costs
Update Standard Costs

Undo Cost Update

View Rolled-up Costs
View Scenario Exceptions

Compare Standard Costs
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Cloud Costing Setups: SLA Mapping Sets (Overview)

[0 Each Cost Distribution Has Journal Lines
[0 Each Journal Line Has the “Purpose” of the Journal Line
[0 This is called the Accounting Line Type

[0 The Cost Distributions are mapped to the full accounting string (CCID) by Accounting Line Type

Excellent Collaborate 18 paper on Oracle Cloud Costing SLA:
3 Tips & Tricks to Setup Oracle Cloud Cost Management
Ehab Khadr, Sr. Manager ERP, Jade Global Consulting

A*A COLLABORATE
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Cloud Costing Setups: SLA Mapping Sets (Example)

Each Cost Distribution Has Journal Lines

Create Cost Distributions process generates these journal lines

Material Transaction Journal Lines Accounting Line Type
Account Alias Issue Debit Offset Account Offset
Credit Inventory Valuation Inventory Valuation

Create Accounting process takes the SLA Mapping Sets (by Accounting Line Type) and assigns the
full accounting string (code combination id) to these journal lines

Note: to simplify, the above example is ignoring the Cost Variance accounting line type,
which is only used by Perpetual Average and Actual (FIFO) Costing

A COLLABORATE

Slide 51 "“‘, ML bl



Cloud Costing Setups: SLA Mapping Sets (Example)

[0 Mapping Sets for

= ORACLE

Functional Areas Change Feature Opt In

* Shipping =3
Receipt Accounting Shared ﬂ
* Cost Accounting . EB
* Cost and Profit Planning =
* Landed Cost Management [« |
* Intrastat Reporting [+ |
* Manufacluring Master Data [ ~ |
Structures Shared n
Supply Chain Collaboration n

Account Alias Txns &

Setup: Manufacturing and Supply Chain Materials Management

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Mapping Sets

Search Tasks

Cost Accounting

View v Format w

Task

Manage Account Rulg
Manage Descriglfon Rules
Manage Mapping Sets
Manage User-Defined Formulas
Activate Subledger Journal Ent

Import Supporting Reference Ini

= ORACLE

b Search

4 Search Results

Actons v Viewv o [H # X

Name

Accrual Account - Organization
Asset In-Transit Valuation

Batch Size Variance

Bridging

Component Substitution Variance
Consigned Clearing

Consigned In-Transit

Consigned Inspection

Consigned Inventory Offset

Manage Mapping Sets: Cost Management

Description

Mapping set created for account rule:
Mapping set created for account rule:
Mapping set created for account rule:
Mapping set created for account rule:
Mapping set created for account rule:
Mapping set created for account rule:
Mapping set created for account rule:

Mapping set created for account rule:

Asset In-Transit Valuation

Batch Size Variance

Bridging

Component Substitution Variance
Consigned Clearing

Consigned In-Transit

Consigned Inspection

Consigned Inventory Offset

COLLABORATE19
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Cloud Costing Setups: SLA Mapping Sets (Example)

[0 Mapping Sets for
Account Alias Txns &

= ORACLE

Manage Mapping Sets: Cost Managem

b Search

4 Search Results

Actions v View v + B

Interorganization Ry
Inventory Valuation
Inventory Variance Gain Loss

Inventory VWrite-Off

Invoice Price Variance Account - Organization

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Mapping Sets => Inventory Valuation

= ORACLE

Edit Mapping Set

Name Inventory Valuation

Short Name CST_INVENTORY_VALUATION

Description Mapping set created for account
rule: Inventory Valuation

Qutput Type Account combination

4 Input Sources
View w
Numbe! Input Source
1 Inventory Organization Code
2 Subinventory Code
3 Costing Category ldentifier

4 ltem Number

Search for people

Actions w

SCM_IMPL ~

@ Save and Close | Save and Create Another

Subledger Application Cost Management

Status Active

Created By Oracle

Value Set Lookup Type  Segment

CST_XLA_EGP_CA

ﬂ*-) COLLABORATE 19
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Cloud Costing Setups: SLA Mapping Sets (Example)

[0 Mapping Sets for
Account Alias Txns

4 Chart of Accounts

View w 3+ X

Chart of Accounts

US Chart of Accounts

Setup and
Maintenance

US Chart of Accounts: Mappings

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Mapping Sets => Inventory Valuation

Export into
When entering Input values, enter a value, an asterisk to represent any value, or leave blank for no value.
Excel
Vieww = ¥ FEexporw [38 Import » =" Detach
& E‘e E‘e
Input A Effective Start  Effective End
Default s s
Inventory Organization Code Subinventory Code Costing Category Item Number U3 Chart of Accounts
001 % v ® 101.00.14100.000.000.000 @" E'e F@
L4 >
A'A COLLABORATE
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[0 Mapping Sets for

TN s W P =

W =l
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Cloud Costing Setups: SLA Mapping Sets (Export Example)

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Cost Accounting => Manage Mapping Sets => Inventory Valuation (exported)

Account Alias Txns

A B C D E\F|GHI|)J K L M
Subledger Application Cost Management
Mame Inventory Valuation
Short Name CST_INVENTORY_WVALUATION
Chart of Accounts US Chart of Accounts
Inventory Organization Subinventory Costing Category Iltem Effective Start Date Effective End Date
Code Code Identifier Number Output (M/d/vy) (M/d/vy)
'[101 * * * 101.00.14100.000.000.000

“Wildcard” value

— Note: you cannot have a wildcard (*) value followed by a “real” value
For example, 001.*.1000.* is not an allowed entry




[0 Mapping Sets for
Receiving Txns
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Cloud Costing Setups: SLA Mapping Sets (Receipt Accounting)

Functional Areas

% Catalogs
Inventory Management
Receiving

X Shipping
Receipt Accounting

* Gost Accounting

* Cost and Profit Planning

Menu Path: Setup and Maintenance => Manufacturing and Supply Chain Materials
Management => Receipt Accounting => Manage Mapping Sets

Setup
Maintenance

Change Feature Opt In

Shared (KD
| v ]
Shared [l
=
Shared (D
%> BB
&S

Setup: Manufacturing and Supply Chain Materials Manager

Search Tasks

Receipt Accounting

Description Ruleq

Supporting Refer

Manage Mapping Sets

Manage User-Defined For

Manage Mapping Sets: Receipt Accounting

b Search

4 Search Results

Actions w View w + B

4 vame

Accrual

Asset In-Transit Valuation
Clearing

Consigned Accrual
Consigned Clearing
Consigned In-Transit
Consigned Inspection
Consigned Payable

Exchange Variance Adjustment

Description

Mapping set created for account rule: Accrual

Mapping set created for account rule: Asset In-Transit Valuation
Mapping set created for account rule: Clearing

Mapping set created for account rule: Consigned Accrual
Mapping set created for account rule: Consigned Clearing
Mapping set created for account rule: Consigned In-Transit
Mapping set created for account rule: Consigned Inspection
Mapping set created for account rule: Consigned Payable

Mapping set created for account rule: Exchange Variance Adjustment
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Cloud Costing Set Up Steps

Define Users and User Data Access

Define Reference Sets (Optional) and Assign Users

Define Cost Organizations

Define Cost Books and Cost Organization Relationships

Assign Cost Books/Cost Organizations to Inventory Org(s)

Define Cost Elements and Analysis Groups (Optional)

Define Cost Components (Optional)
Define Valuation Sets

Define Cost Policies and Cost Profiles

Assign Default Cost Profiles to Items

Set Up Subledger Accounting

Q COLLAB(TATE
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Cost Organizations Example

] Partition Access by Cost Organization

can also access...

» Cost Elements

= Cost Component Mappings

= Valuation Structures
= Cost Profiles

can also access...

1 Reference Data Sets Controls Access to:

has access to ... / \ | --- has access to
A\ 4 v
UK US Cost Japan
Cost Org rg Cost Org
v v v v v v v v v v
Costing for Costing for Costing for Costing Costing Costing Costing Costing for Costing for Costing for
Leeds London Birmingham for SFO for Dallas for Boston for Miami Osaka Tokyo Yokohama
Inventory Org Inventory Org Inventory Org K Org Org Org Org / Inventory Org Inventory Org Inventory Org
ﬂ'\ COLLABORATE




Summary

Cloud Costing is Very Different

Takes at least ten times more effort and time to set up
Many more steps
Less intuitive — no Cost Types
Lots and lots of data replication processes
Significant amount of SLA setups, both for Cost Accounting and Receipt Accounting

More features
Unlimited cost elements with 5 cost element types
Shared setups by Reference Data Sets
Overhead and Resource Cost Pools
Cost Elements
Valuation Structures
Cost Profiles
Each item has its own costing method

) 4

Costing by inventory org, item, subinventory, lot, serial number or grade. £'A COLLABORATE
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doug@volzconsulting.com

Session ID:

10736

Remember to complete your evaluation for this session within the app!
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